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Rozdział 1. MagicQ Visualiser 

1.1. MagicVis 

Oprogramowanie MagicQ posiada dedykowany wizualizer MagicVis pracujący na 
systemach Windows, Mac oraz 

Linux.

 
 
MagicVis jest dostępny w dwóch wersjach: 
 

 Samodzielna aplikacja MagicVis, umożliwiająca podłączenie konsolety 
MagicQ lub każdej innej za pomocą systemów ArtNet lub ACN. 

 

 MagicVis jest również wbudowany w oprogramowaniu MagicQ PC. To 
pozwala na edycję i wizualizację projektu na jednym komputerze. 

 
Aplikacja MagicVis jest gotowa do działania praktycznie zaraz po podłączeniu 
konsolety MagicQ za pomocą przewodu sieciowego oraz uruchomieniu aplikacji 
MagicVis. Aplikacja wykorzystuje wewnętrzną kartę graficzną i procesor komputera, 
w ten sposób nie obciąża konsolety MagicQ pozwalając jej pracować z pełną 
wydajnością. 
 
Podczas wizualizacji MagicVis używa karty graficznej PC / Mac - lepsza wydajność 
karty graficznej to lepsza jakość obrazu. Komputery PC i MAC z współdzieloną 
pamięcią dla karty graficznej będą działać wolniej, co pozwala na renderowanie tylko 
małych projektów. Podobnie używając MagicQ PC oraz MagicVis na jednym 
komputerze. Zalecanymi kartami są Nvidia lub ATI/Radeon na poziomie cen od 500zł 
w górę. 
 
1.1.1. Konfigurowanie MagicVis na oddzielnym komputerze. 
 
Zewnętrzna aplikacja MagicVis może być połączona z konsoletą lub z 
oprogramowaniem MagicQ na osobnym komputerze PC/Mac. Nasz projekt zostanie 
automatycznie załadowane do wizualizera przez sieć. 
 



 

 

Adresy IP zarówno na konsolecie jak i laptopie muszą być z tego samego zakresu 
adresów IP, na przykład w konsolecie ustawiamy adres IP 2.0.0.1 oraz maskę sieci 
255.0.0.0 a w laptopie IP 2.0.0.2 z maską 255.0.0.0. W konsolecie trzeba jeszcze 
zmienić ustawienia: 
 
[SETUP] → VIEW SETTINGS → Multi Console 
 
Funkcje Enable Remote Control i Enable Remote Access muszą być ustawione 
na 'yes'. 
 
Podłącz konsoletę oraz komputer PC / Mac za pośrednictwem przewodu sieciowego 
z przeplotem. Po włączeniu MagicVis kliknij File → Settings..., aby otworzyć 
ustawienia okna. Kliknij na Network, następnie w karcie wybierz adres IP 
podłączonej konsolety MagicQ. Jeśli jest tylko jedna konsoleta w sieci MagicVis 
powinien automatycznie się z nią połączyć. Jeśli nazwa konsolety wyświetli się na 
czerwono upewnij się, że Enable Remote Control i Enable Remote Access jest 
ustawione na 'yes'. Jeżeli adres IP wyświetla się na czerwono, należy sprawdzić czy 
adresy IP oraz maski sieci zastały wprowadzone poprawnie. 
 

 
 
Prawidłowo połączony i synchronizowany MagicVis powinien aktualizować zmiany 
projektu wprowadzone na konsolecie w czasie rzeczywistym. 
 
Początkowo pasek stanu w MagicVis pokaże Searching for Consoles, a następnie 
Waiting for Connection aż połączy się z konsoletą. Gdy nastąpi połączenie z 
konsolą, pojawi się komunikat Waiting Sync. Gdy dane zostaną już przeniesione z 
konsolety do wizualizera MagicQ wyświetli się komunikat Synced. 
Jeśli program nadal będzie wyświetlał Waiting for Connection,  sprawdź ustawienia 
adresu IP, maski sieci oraz czy zapory sieciowe w komputerze są wyłączone. W 
niektórych systemach może być konieczne wyłączenie innych kart sieciowych, takich 
jak karty sieci bezprzewodowej. 
 
MagicVis domyślnie zakłada, że będzie otrzymywać dane DMX poprzez ArtNet 
zaczynając od ArtNet Universe 0-0.Jak tylko MagicVis zostanie połączony z 
konsoletą zaczyna się odbiór danych od wszystkich skonfigurowanych linii w 
konsolecie. 



 

 

Jeśli nie są one włączone w konsolecie to konsoleta wysyła dane DMX bezpośrednio 
do MagicVis przy użyciu własnego protokołu MagicVis. Umożliwia to pracę w 
systemie, w którym wyjścia nie są włączone. 
 
Należy pamiętać, że nawet wtedy, gdy MagicVis nie jest zsynchronizowany, 
konsoleta wysyła dane po sieci ArtNet. 
 

1.1.2. Konfigurowanie MagicVis z konsolami innych producentów. 

 
MagicVis może być używany z konsoletami innych producentów. 
Wizualizacja projektu musi być stworzona w MagicQ PC po czym załadowana do 
MagicVis. Adresy DMX oraz ustawienia sieci ArtNet muszą być identyczne jak w 
wizualizerze. 
 
Aby załadować plik MagicQ bezpośrednio do MagicVis: 
 
File →Load Show. 
 

 

Jeżeli projekt został załadowany bezpośrednio do programu, 
MagicVis nie będzie automatycznie synchronizował się z konsoletą. 

1.1.3. Praca z MagicVis w MagicQ PC. 

 
Uruchom oprogramowanie MagicQ PC następnie przejdź do Visualiser menu w 
pasku menu i kliknij Show Visualiser. Rozmiar i położenia okna wizualizera można 
dowolnie zmieniać. 
 

 
 
Gdy korzystamy z wewnętrznego wizualizera aplikacji MagicQ, nie jest wymagane 
konfigurowanie adresu IP lub wyjść sieciowych. 
 
2. Obsługa MagicVis 
 
MagicVis posiada pięć widoków - perspektywa, góra, bok, przód oraz ruchomy/free. 
Wygląd może być zmieniony albo w MagicVis → View lub MagicQ → Patch , za 
pomocą przycisku programowego E. Widoki góra, bok, przód oraz ruchomy są 



 

 

domyślnie ustawione. Jeżeli przesuniemy kamerę widoku za pomocą myszki to 
program automatycznie zmienia status widoku na ruchomy. 
 
Można obracać kamerę dookoła, wskazując myszą w oknie wizualizera, klikając i 
przytrzymując prawy przycisk myszy, a następnie poruszając myszą. Ruch w przód, 
w tył wykonujemy kołem myszy lub naciskając klawisz [CTRL] i klikając prawym 
przyciskiem myszy. Przytrzymaj naciśnięty klawisz [SHIFT], kliknij i przesuń mysz, 
aby przesunąć kamerę, przytrzymaj klawisz [SHIFT] i porusz kołem myszy aby 
skorzystać z funkcji zoom. 
 
Poziom oświetlenia w pomieszczeniu można zmienić wybierając w menu: 
MagicVis → View → Dark 
 

 W oprogramowaniu MagicQ w folderze demo został umieszczony plik pokazowy 
ExhibitionDemo. Jest to projekt w pełni wykorzystujący możliwości wizualizera, który jest w 
pełni skonfigurowany z MagicQ oraz MagicHD. Prezentuje on możliwe zastosowania w/w 
oprogramowania 

 

1.2.1. Ładowanie Urządzeń do MagicVis. 

 
Po spatchowaniu pierwszego urządzenia w projekcie, MagicQ zapyta się, czy chcesz 
aby urządzenia były dodawana do wizualizera automatycznie. 
 

 
 
MagicQ w danym projekcie tylko raz pyta czy ładować automatycznie urządzenia. 
Jeśli chcesz zmienić ustawienia, możesz włączyć lub wyłączyć automatyczne 
wstawianie urządzeń w: 
 
 [SETUP]→ VIEW SETTINGS → Mode → Visualiser 
 
Po dodaniu urządzeń w VIEW HEADS, MagicQ tworzy je nie tylko w widoku 
przeglądania VIEW HEADS ale także generuje obiekt dla wizualizatora w VIEW VIS. 
 
Urządzenia w wizualizerze są oddzielone od urządzeń w MagicQ. Można mieć wiele 
urządzeń w wizualizerze przyporządkowane do jednego urządzenia w projekcie – 
np. dwa urządzenia sterowane przez jeden kanał DMX – dwa reflektory sterowane 
przez jeden kanał w dimerze. 
 
Domyślnie podczas ładowania urządzeń do MagicQ, wizualizer tworzy jeden obiekt 
dla każdego urządzenie z MagicQ. Można też dodać dodatkowe obiekty do 
wizualizatora za pomocą funkcji INSERT znajdującej się w VIEW VIS. 



 

 

 
 
1.2.2. Opis funkcji View Vis. 
  
[PATCH]→ VIEW VIS 
 
View Vis służy do zarządzania różnego typu obiektami w wizualizerze. W tej chwili 
dostępne są trzy podstawowe zakładki konfiguracyjne, tj. Selected Heads, Vis 
Heads, i Attach Objects. 
 

 
 
W zakładce Selected Head na liście pojawiają się aktualnie wybrane urządzenia. 
Urządzenia można wybrać w widoku Group lub bezpośrednio z klawiatury 
numerycznej. W tym widoku enkodery i przyciski programowe będą wprowadzać 
zmiany pozycji w wizualizerze dla wszystkich urządzeń z listy. 
 
W Vis Head, są pokazane wszystkie urządzenia obecne w wizualizerze. W tym 
widoku enkodery i przyciski programowe operują aktualnie zaznaczonymi obiektami 
na liście. Użyj klawiszy [SHIFT] / [CTRL] i strzałek, klawiszy, aby zaznaczyć więcej 
urządzeń jednocześnie. 
 
Attach Object, w tym widoku znajdują się wszystkie inne obiekty, oprócz urządzeń, tj. 
konstrukcje, bryły, manekiny. Tutaj również enkodery i przyciski programowe operują 
aktualnie zaznaczonymi obiektami. Użyj klawiszy [SHIFT] / [CTRL] i strzałek, 
klawiszy, aby zaznaczyć więcej urządzeń jednocześnie. 
 
1.2.3. Rozmieszczanie urządzeń w programie MagicVis. 
 
Po załadowaniu nowych urządzeń do projektu automatycznie pojawiają się one w 
zakładce wybranych urządzeń 
 
[PATCH] --> VIEW VIS --> Selected Heads     
 
będziesz mieć bezpośrednią kontrolę pozycjonowania i orientacji urządzeń za 
pomocą enkoderów i przycisków programowych. 
 
Enkodery X, Y i F służą do ustawiania pozycji w osiach X, Y i Z. 



 

 

Z czego oś X to oś pozioma, Y – pionowa, Z – głębokość. 
 
Naciśnięcie przycisków programowych X, Y i F zmienia pozycję o +1 metr na danej 
osi. Naciskając [SHIFT] + przycisk programowy X, Y i F zmienia pozycję o -1 metr na 
danej osi. 
 
Użyj funkcji [FAN] + Enkoderów X,Y, F do rozsuwania od siebie obiektów w osiach X, 
Y lub Z. 
 
Enkodery B, C i D służą do rotacji obiektów wokół osi X, Y i Z. 
 
Naciśnięcie przycisków programowych B, C i D obraca obiekt o 90 stopni wokół 
danej osi. Naciśnięcie klawiszy [SHIFT] + przycisk B, C i D obraca urządzenia o - 90 
stopni wokół osi. 
 
Możesz również wpisać wartości bezpośrednio w widoku arkusza w View Vis za 
pomocą klawiatury numerycznej. 
 
Możesz zmienić kilka wartości jednocześnie, korzystając z klawiszy [SHIFT]/[CTRL] i 
kursorów aby zaznaczyć więcej pozycji na liście. Użyj [THRU] aby wprowadzić 
wartości od/do w zadanej przestrzeni, np -5 [THRU] 5 rozstawia obiekty 
równomiernie w danej osi pomiędzy wartościami -5 i +5 metrów. 
 

1.2.4. Obiekty. 

 

 
 
W zakładce Attach Objects wstawić można konstrukcje, rury, bryły oraz 
pomieszczenia. Ściany, manekiny, przedmioty i meble nie są obecnie obsługiwane. 
 
Aby utworzyć obiekt, naciśnij przycisk programowy Insert, a następnie wybierz 
rodzaj obiektu jaki ma być utworzony. Utworzony obiekt dodawany jest do listy. Aby 
dodać kulę lub walec utwórz obiekt Form a następnie w kolumnie Model, naciśnij 
przycisk Set i wybierz żądany kształt. 
 



 

 

Wprowadź wymiary obiektu długość, szerokość i wysokość. Aby wpisać wartości w 
stopach należy dopisać znak ‘/’, np. 10/ . 
Wstaw konstrukcje lub rury, dostosuj ich wymiary oraz pozycje, nadaj indywidualną 
nazwę dla konstrukcji lub grupy konstrukcji, aby móc przyporządkować do nich 
urządzenia.  
 
Po dodaniu konstrukcji lub rury możliwe jest przyporządkowanie do nich urządzeń, 
które są używane w projekcie. Jeśli na przykład dodasz 6 spotów po dodaniu 
konstrukcji, to będą one rozłożone równomiernie na długości konstrukcji. 
 
Podczas tworzenia raportów, dostępne są wszystkie widoki, jeżeli urządzenia są 
połączone z konstrukcjami możliwe jest wtedy raportowania pojedynczych 
konstrukcji z rozmieszczeniem urządzeń, ich adresami i numerami. 
 

 

Wstaw konstrukcję i ustaw jako Invisible, przydziel do niej urządzenia i stwórz wydruk 
dla nich. 
 
Na przykład w projekcie ExhibitionDemo używane są urządzenia PixelLine które można 
przypisać do pojedynczych pionowych rur. Ale w MagicVis są one wszystkie 
przymocowane do ukrytej konstrukcji, która jest tak obrócona, że gdy tworzymy 
wydruk, PixelLines widoczne są tylko jako prawidłowo ułożone urządzenia. 

 

1.2.5. Przypisywanie urządzeń do obiektów. 

 
Urządzenia mogą być przypisane do konstrukcji lub rur w dowolnej chwili. Wybierz 
urządzenia, które chcesz przypisać, korzystając z grup lub z klawiatury numerycznej. 
 
VIEW VIS → SELECTED HEADS i naciśnij FIT TO OBJECT 
 
Opcjonalnie w zakładce Vis Heads, kliknij dwukrotnie na polu Attach. MagicQ 
wyświetli listę wszystkich dostępnych obiektów do wyboru. 
 
Urządzenia które są powiązane z danym obiektem będą razem z nim przesuwane. 
Urządzenia przypisane do Truss 1 będą zmieniały swoje położenie razem z ruchem 
obiektu Truss 1. 
 
MagicVis obsługuję funkcję Hang Types, która pozwala przypisać urządzenia do 
obiektów w określonej orientacji w przestrzeni. Informacja ta drukowana jest także na 
raportach w MagicVis. Dostępne opcje Hang Type: Normal, Bottom rear, Bottom 
front, Top rear, Top front face up, Top front face forwards, Top boom, and Bottom 
Boom.  

1.2.6. Modyfikacja kąta wiązki światła i typu urządzenia 

W Patch → View Heads dla urządzeń typu Generic istnieje możliwość ustawienia 
typu/formatu urządzenia oraz kąta wiązki światła. Określenie tych wartości 
powoduje, że nadpisują one wartości domyślne dla wybranego urządzenia. Format 
urządzenia znajduje się na wydruku Fixture Patch. 

Jeśli konieczna jest zmiana kąta wiązki dla innych urządzeń niż Generic wtedy 
zmian należy dokonać w edytorze urządzeń dla wybranego urządzenia określając 
parametry Zoom Narrow i Wide. 



 

 

1.2.7. Konfiguracja Media serwerów w MagicVis. 

 
W MagicVis można stworzyć ekrany o dowolnych wymiarach i kształtach 
wyświetlające obraz z media serwerów, w tym także z MagicHD. Wpierw należy 
upewnić się, że w konsolecie w oknie Media widoczny jest bieżący podgląd 
zawartości media serwera. Następnie w MagicVis w zakładce Attach Objects wybierz 
Form. Ustaw Model jako Sheet i w kolumnie Texture wpisujemy mp + numer media 
serwera. Numer Media Servera można znaleźć w: 
 
[SETUP] →  View System →  View Media 
 
Przykład: jeśli media serwer w View Media byłby pierwszy na liście to w polu Texture 
wpisujemy mp1. Jeśli MagicVis nie jest w stanie połączyć się z media serwerem 
pojawi komunikat "Media Server 1". Jeśli po 1 minucie nadal nie będzie połączenia  
wyświetlany tekst zniknie. Podgląd odbywa się poprzez CITP, obraz jest wtedy 
wyświetlany w niskiej rozdzielczość. 

1.2.8. Zmiana położenia konstrukcji 

 
Aby stworzyć obiekt sterowany za pomocą kanałów DMX należy wybrać i 
zaadresować urządzenie o nazwie Movement z biblioteki Generic. Następnie w 
Patch, w zakładce Vis Heads w kolumnie Attach wpisać nazwę urządzenia 
Movement (taką jaka jest wpisana w Attach Objects) przy tych urządzeniach które 
chcemy połączyć z wybraną konstrukcją. Każde urządzenie połączone z tą 
konstrukcją będzie razem z nią zmieniać swoje położenie. 
 
Urządzenie Generic Movement posiada osie pozycji X, Y, Z  oraz rotacji X, Y, Z co 
umożliwia całkowitą kontrolę obiektu przez MagicQ. Należypamiętać że jest to 
wirtualne urządzenie które aby działało poprawnie musi być zaadresowane. 
 

 W ExhibitionDemo showfile są 2 sztankiety ruchome. Każdy sztankiet ma ekran z nim 
powiązany, w którym jest renderowany obraz bezpośrednio z media serwera. 
Umożliwia to symulację ruchu, np. ściany LED w czasie rzeczywistym. 



 

 

1.2.9. Kontrola ruchu kamery za pomocą kanału DMX 

 
Urządzenie Camera umożliwia pogląd wizualizera, może być kontrolowana z 
poziomu konsolety MagicQ. Gdy urządzenie Generic Camera jest dodane w oknie 
Patch, a atrybuty kamery Mode Attributes nie mają wartości zerowych to widok w 
wizualizerze jest kontrolowany przez Camera. Generic Camera to wirtualne 
urządzenie które aby działało poprawnie musi być zaadresowane. 
 
Aby użyć kamery wybierz urządzenia Camera i wciśnij przycisk [LOCATE]. Kamera 
ustawi się w trybie perspektywy i w pozycji domyślnej. Wybierz okno pozycji i teraz  
używając enkoderów możesz w pełni kontrolować widok w wizualizerze. 
 
Aby wrócić do kontroli ręcznej ustaw enkoderem A wartość Disabled. 
 
Kamera kontroluje również oświetlenie pomieszczenia jak i samych urządzeń. 
Atrybuty te znajdują się oknie Beam.  
 

 

FX mogą być stosowane do położenia i obrót przypisuje się muchę kamery wokół 
wizualizer i dają dynamiczny widok projektowania. 

 

1.2.10. Usuwanie urządzeń i obiektów z MagicVis 

 
Aby usunąć obiekt z wizualizera przejdź do zakładki VIEW VIS → Vis Heads i 
umieścić kursor na wybranym urządzeniu. Naciśnij przycisk Remove. Aby wybrać 
więcej urządzeń do usunięcia użyj klawiszy [SHIFT] / [CTRL] i klawiszy kursora. W 
celu usunięcia obiektu przejdź zakładki VIEW VIS → Attach Object i postępuj 
zgodnie z tą samą procedurą. 
 
Kiedy urządzenia są usuwane z wizualizer nie są one usuwane z projektu MagicQ. 
Usunięcie urządzenia z projektu MagicQ (w oknie Patch) usuwa także urządzenia w 
MagicVis. 
 

1.2.11. Dostosowanie przestrzeni roboczej projektu. 

 
Możliwa jest zmiana wielkości przestrzeni roboczej pomieszczenia w którym chcemy 
pracować. Domyślny rozmiar pomieszczenia to 20 x 20 x 20m. Aby zmienić rozmiar 
przestrzeni należy dodać nowy obiekt typu Room. Po dodaniu tego obiektu MagicVis 
przyjmie teraz jako rozmiar przestrzeni roboczej wymiary obiektu Room. Jedynie w 
tym przypadku utworzony obiekt zastępuje istniejący. Punkt zerowy jest zawsze na 
środku podłogi pomieszczenia. 
 
W zakładce Attach Object naciśnij INSERT. Wybierz obiekt typu Room i określ jego 
długość, szerokość oraz wysokość. 



 

 

 

1.2.12. Tworzenie wydruku raportów 

 
MagicVis pozwala również na tworzenie rysunków i arkuszy zawierających spis i opis 
urządzeń. W oknie MagicVis kliknij File → Paperwork. 
Pojawi się okno Reports. 
 

 
 
Możesz wybrać, co i w jakim zakresie chcesz uwzględnić na wydrukach oraz 
utworzyć dokument w formacie PDF. Można także wyeksportować listę urządzeń z 
ich adresami oraz innymi informacjami do arkusza kalkulacyjnego LibreOffice Calc 
lub Excel. W tym celu kliknij na jeden z przycisków Export CSV...co spowoduje 
załadowanie pliku CSV do arkusza kalkulacyjnego. Następnie można dodać 
dodatkowe kolumny oraz ułożyć je wg wymogów projektu. 



 

 

 
 
Wydruk Plots zawiera plany rozmieszczenia wszystkich obiektów wykorzystanych w 
wizualizerze. 
 
Wydruk Patch Sheets zawiera wszystkie urządzenia znajdujące się w widoku Patch, 
nawet jeśli nie zostały one użyte w wizualizerze. 
Dlatego można utworzyć arkusz z listą urządzeń bez konieczności rozmieszczania 
ich w wizualizerze. 
 
Wydruk Positions zawiera  pozycję, wysokość i rozmiar kratownic oraz rur, wraz z 
przybliżoną masą zawieszonych urządzeń oraz opisem, z której linii DMX korzystają. 
Podana masa jest wagą obiektów i nie obejmują ciężaru okablowania, konstrukcji 
itp.. 
 
Należy pamiętać, że jest to jedynie narzędzie do szacowania obciążenia i nie 
może być podstawą do obliczeń inżynieryjnych. 
 

1.2.13. Tworzenie sceny wizualizera ze starszych projektów MagicQ 

 

Starsze pliki projektów mogą być ładowane do nowszego MagicQ, ale nie będą 
zawierać zdefiniowanych urządzeń dla wizualizera. Procedura stworzenia 
wizualizacji na podstawie urządzeń ze starego projektu jest bardzo prosta. 
 
Wybierz urządzenia za pomocą grup lub klawiatury numerycznej. 
Następnie przejdź do : 
 
[PATCH]→ VIEW VIS → Selected Head 
 
i naciśnij przycisk INSERT SELECTED. Zostanie utworzone urządzenie wizualizera 
dla każdego z wybranych wcześniej urządzeń. 
 
Aby dołączyć i rozmieścić wybrane urządzenia do istniejącego obiektu, np. 
konstrukcji, użyj funkcji  FIT TO OBJECT 



 

 

 
Można również wstawić wszystkie urządzenia z danego projektu do wizualizera 
jednocześnie. Upewnij się, że urządzenia nie są zaznaczone, a następnie przejdź 
do: 
 
[PATCH] → VIEW VIS → Vis Head 
 
i naciśnij przycisk INSERT PATCHED. Zostaną utworzone urządzenia wizualizera dla 
każdego z urządzeń użytego w projekcie. Urządzenia zostaną rozmieszczone w 
postaci siatki. 
 

1.2.14. Konwertowanie siatki z MagicQ do widoku wizualizacji 

 
Możliwe jest konwertowanie siatki z MagicQ Plan View do widoku wizualizera. W 
oknie Output  w zakładce View Plan naciśnij przycisk [SHIFT] + ARRANGE VIS. 
MagicQ poprosi o wskazanie płaszczyzny, w której ma rozmieścić urządzenia w 
wizualizerze. 
 

 
 
Dla każdego z urządzeń na siatce będzie utworzone urządzenie w wizualizerze. Ich 
wzajemne rozmieszczenie będzie odzwierciedlało pozycję na siatce. 
 
Np. jeśli wybierzesz Top, to MagicQ potraktuje siatkę jakby to był widok z góry i 
wszystkie urządzenia zostaną umieszczone w górnej części pomieszczenia na 
jednej wysokości. 
 

1.2.15. Ustawienia wyświetlania wizualizacji. 

 
MagicVis zawiera ustawienia pozwalające dostosować wygląd wizualizacji. 



 

 

 

 
 
 

W przypadku korzystania z dużej ilości urządzeń LED w systemach z kartami 
graficznymi o mniejszej mocy obliczeniowej, zalecane jest ustawienie opcji „Don't 
draw LED beams”. 
 

1.2.16. Rzuty sceny 

MagicQ zawiera okno Plot Window pokazujące pozycję oraz orientację urządzeń na 
planie sceny. Plot Window może wyświetlać widok z przodu (Front), od góry 
(Overhead) i z boku (Side) lub z rozgraniczeniem na urządzenia, które są 
podwieszone do konstrukcji lub umieszczone na podłodze. Obraz może być 
przesuwany, przybliżany i oddalany. Widok można ograniczyć tylko do zaznaczonych 
urządzeń lub do wszystkich dostępnych. Urządzenia mogą być wybierane 
bezpośrednio z rzutu sceny poprzez pojedyncze kliknięcie (dotknięcie ekranu) lub 
wielokrotne w celu wybrania kilku urządzeń. Informacja o orientacji urządzeń jest 
pobierana z MagicVis i może być edytowana w oknie Patch. 
 
Okno Plot Window jest dostępne dla MagicQ PC Windows, Mac, Linux oraz dla 
MQ1000. Obecnie nie jest dostępne dla konsol Pro oraz Compact. 

Rozdział 2. Funkcja Blind w MagicVis 

MagicQ obsługuje funkcję wizualizacji w trybie Blind  i Preview podczas korzystania 
z MagicVis, Capture lub WYSIWYG. Funkcja ta umożliwia podgląd zawartość 
Programatora konsolety w trybie Blind lub do podglądu zapisanych wartości na 
Playbackach, które nie są aktywne na rzeczywistych wyjściach. 
W konsolecie MagicQ otwórz widok: 
 



 

 

[PATCH] → VIEW VIS → VIS SOURCE 
 
Do wyboru są następujące opcje podglądu: Blind Prog, Output, Playback, Next Go 
 
Po wybraniu trybu „Blind Programmer” MagicQ doda zawartość programatora do 
wizualizacji, nawet gdy programator jest w trybie Blind. 
 
Tryb „Playback” MagicQ pokaże w wizualizerze zawartość wybranego Playbacku 
Fader’a, tak jakby był on odtwarzany realnie i podniesiony na 100%. 
Tylko zawartość wybranego Playback’u jest wizualizowana. 
 
Tryb „Next GO” MagicQ pokaże w wizualizerze następną scenę, jaka będzie 
odtworzona z w ybranego Playback’u. Jeśli Playback zawiera kilka scen to na 
wizualizerze zawsze będzie widoczna następna do odtworzenia.  
Jeśli wybrany Playback nie jest aktywny to MagicQ pokaże scenę, która zostanie 
odtworzona po aktywowaniu Playbacku. 
 
Funkcja BLIND i Preview nie mają wpływu na normalne wyjścia sieciowe, takie jak 
ArtNet, ACN lub Pathport. Tylko zmieniony jest sygnał DMX wysyłany bezpośrednio 
do wizualizera. 
 
Korzystając z programu Capture należy skorzystać z połączenia CITP zamiast z 
ArtNet, w innym przypadku Capture pokaże sygnał wyjściowy z konsolety. 
 

Rozdział 3. Licencje 

 
Uruchomienie MagicQ w systemie operacyjnym Debian Linux. 
http://www.debian.org 
Wykorzystanie biblioteki MicroWindows dla wersji oprogramowania przed v1.5.6.0. 
http://www.microwindows.org 
Program wykorzystuje biblioteki Qt. 
www.http/::qt-project.org: 
Linux i MicroWindows podlegają GNU Publiczna Licencja (GPL). 
Qt jest własnością GNU Lesser Publiczna Licencja (LGPL) 
 
Cechy i funkcje oprogramowania konsolet MagicQ i zawarte w nich idee są 
własnością Chamsys Ltd. Konsola jest przeznaczona do sterowania systemami 
oświetleniowymi. Brak gwarancji wyraźnych lub domniemanych w odniesieniu do 
korzystania z oprogramowania konsolet oświetleniowych MagicQ. 
Firma Chamsys Ltd. Nie ponosi odpowiedzialności za dokładność informacji 
zawartych w niniejszej instrukcji. 
 
Oprogramowanie konsolet oświetleniowych MagicQ jak i produkty MagicQ są 
dostarczane, zaprojektowane i wyprodukowane przez Chamsys Ltd. 
 
Produkty zawierające oprogramowania firmy Chamsys Ltd. oraz przez nią 
sprzedawane są licencjonowane. Sprzedawanie, kopiowanie oraz powielanie w 
jakikolwiek inny sposób bez zgody firmy Chamsys Ltd. jest zabronione. 
 
Chamsys Ltd.nie gwarantuje dokładności, adekwatności, przydatności i kompletności 
wszelkich informacji i produktów oraz nie ponosi odpowiedzialności za jakiekolwiek 
błędy lub niezgodności swoich produktów. 

http://www.debian.org/
http://www.microwindows.org/


 

 

 
Chamsys Ltd. nie ponosi odpowiedzialności za konsekwencje wynikające z 
niewłaściwego lub niezgodnego z jego przeznaczeniem użytkowania. Urządzenie 
jest zaprojektowane, aby spełnić wszystkie aktualne wymagania przepisy 
dotyczących produktów elektrycznych na terenie Wielkiej Brytanii. 
 
Produkty firmy Chamsys Ltd. nie powinny być stosowane w zagrażających lub 
potencjalnie zagrażających życiu krytycznych sytuacjach lub w sytuacjach w których 
sprzęt ten może spowodować obrażenia ciała. 
 
Chamsys Ltd. zastrzega sobie prawo do wprowadzania zmian i / lub poprawy lub do 
zaprzestania wprowadzania zmian w produktach bez uprzedzenia, i doradza 
klientom w celu uzyskania najnowszej wersji lub istotnych informacji aby sprawdzili 
dostępność sprzętu lub oprogramowania przed złożeniem zamówienia. Wszystkie 
produkty są sprzedawane zgodnie z warunkami sprzedaży dostarczonych w 
momencie potwierdzenia zamówienia, w tym odnoszące się do gwarancji, 
naruszenia patentu i ograniczenia odpowiedzialności. Niektóre z dostępnych funkcji 
produktu mogą być zmieniane przez cały okres użytkowania produktu. 
 
Produkty firmy Chamsys Ltd. spełniają szereg dyrektyw UE w stosownych 
przypadkach, na przykład dyrektywy EMC i LVD, ustanowione przez Wspólnotę 
Europejską. Chamsys Ltd. wykonuje okresowe badania produktów, aby zapewnić, że 
produkcja nadal spełniają w/w wymagania i dyrektywy. 
 
Chamsys Ltd. nie przyjmuje zwrotów towaru do naprawy, jeśli numer seryjny, naklejki 
zostaną usunięte lub zatarte w taki sposób, że będą nieczytelne. Odnosi się to 
również do napraw gwarancyjnych. Zobacz szczegółowe warunki sprzedaży. 
 
Wszystkie inne nazwy produktów są znakami towarowymi lub zastrzeżonymi 
znakami towarowymi ich właścicieli. 
 
Żadna część tej publikacji nie może być powielana i rozpowszechniana, przesyłana, 
przepisywana, przechowywana w systemie udostępniania ani tłumaczona na żaden 
język w jakiejkolwiek formie lub w jakikolwiek sposób bez uprzedniej pisemnej zgody 
Chamsys Ltd. 
 
Chamsys Ltd. 2014 
Wszystkie prawa zastrzeżone. 
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